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INTRODUCTION 

 

OVERVIEW 

 

Search and Collect Discoverable Documents and Lists 

SPC allows you to quickly export document libraries, as well as perform targeted collections when 
needed, dramatically reducing the collection size and overall project costs. Common electronically stored 
information (ESI) relevant to litigation is often stored in SharePoint sites, but companies struggle in 
meeting their production requests. They find the built-in search and retrieval features don’t provide a 
means to satisfy their requirements and don’t know where to turn. 

Easy Data Export with Metadata 

Once a user selects relevant items, SPC exports those items to the location of choice. Files can be stored 
on a portable drive or saved to server locations (SANS/NAS). The resulting files include the associated 
metadata and detailed chain of custody that lists the date/time, hash value and other details that ensure 
a fully defensible ESI collection. 

No Local Installation Required 

Like other Pinpoint Labs products, SPC can be run from a flash drive or external hard drive without any 
local installation. In fact, remote collections have been completed where users only need access to the 
SharePoint website link and can collect data from a secure location. This significantly reduces hurdles 
often encountered by the IT staff in trying to service many requests. Pinpoint Labs ESI collection products 
are relied on every day by many Fortune 500 companies, government agencies, and legal departments 
worldwide. 

With SharePoint Collector: 

 Retrieve Contents From All Sites (intranet portals, extranet sites, Internet and cloud locations) 
 Collect Everything (documents, lists, calendar, contacts, announcements, attachments, Wiki, blogs) 
 Extract File Metadata (embedded information that traces history, access or usage) 
 Maintain Chain of Custody (validation that evidence not altered or changed from the time it was 

collected) 
 Collect Relevant User Data (ID, name, email address, personal profile, etc.) 
 Retain Folder/File Structure and Display File Lists 
 Run from Flash/USB Drive and Resume Incomplete Jobs 
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INSTALLATION 

 

SharePoint Collector can be licensed to a variety of media (USB flash drives, external and internal hard drives).  

 

The license can easily be deactivated and reactivated on a different device when needed. 

ONLINE REGISTRATION 

 

To install and activate SharePoint Collector online, follow these steps: 

1) Download SharePoint Collector 
2) Extract the .zip file contents to desired location. 
3) Run SharePoint Collector.exe 
4) Choose Online Activation 
5) Enter your Account ID 
6) Click Register 
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OFFLINE REGISTRATION 

 

To install and activate SharePoint Collector offline, follow these steps: 

1) Download SharePoint Collector 
2) Extract the .zip file contents to desired location. 
3) Run SharePoint Collector.exe 
4) Enter your Account ID 
5) A serial number will be generated. Send this serial number and your account ID to 

support@pinpointlabs.com or call 1-888-304-1096. 
6) Pinpoint Labs will provide you with the activation key. Enter this in the space provided and click 

Register.  

OPENING A SHAREPOINT SITE 

 

To start using SharePoint Collector: 

Click on the ‘File’ tab and choose ‘Open Site’ 

 

The ‘Open Site’ window will open. Click ‘Add’ to set up the sites you wish to collect. 

These sites can later be modified or deleted as needed from this menu. Select the site in the drop-down 
menu, click on the ‘Edit’ tab and choose ‘Modify’ or ‘Delete’. 

mailto:support@pinpointlabs.com
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After clicking add or edit, the ‘Site Management’ window will open. 

Enter the same URL address used to open the site with a Web browser.  

Enter a User Name and Password, and then click ‘OK’. 

 

NOTE: SharePoint Collector uses Triple DES encryption standard as approved by the National Institute of 
Standards and Technology (NIST) to encrypt stored passwords. 
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Credential Types: 

Current Windows User: Windows authentication using current logged on user. Current user is the same as 
SharePoint credentials except the credentials used are those of the user currently logged onto the system running 
SPC. The network must support Integrated Windows Authentication to use this feature.  

Office 365: Federated authentication. Enter the SharePoint URL and click the Office 365 radio button. The user id 
and password fields are used for documentation only and not used to log in. After the site data is entered, the site 
can be selected and the SharePoint Collector will connect to SharePoint. Since SharePoint is using Office 365, the 
connection will be redirected to the Federated authentication server. The user will be presented with an 
authentication page. A token is returned to SPC and this is used for all requests to SharePoint. Tokens can have an 
expiration date.  

NOTE: If a token expires while data collection or data export is active, a new request will be made to the 
security provider for a new token. This request may result in a new log in page being shown which will 
require the user to re-enter the sign on data. 

SharePoint: Windows authentication. SharePoint credentials are the credentials of a valid windows user, on the 
host system running SharePoint. The credentials used are the user name and password provided in the site 
management dialog. If the user name and/or password are not provided in the site list, the SPC Site Credentials 
prompt will be shown to get the missing credential. 

NOTE: If no credentials are provided, the user’s credentials given when logging into the computer will be 
used. 

To open a SharePoint site after it is set up, highlight the site you wish to open in the drop-down menu and click 
‘OK’. 

 

After clicking ‘OK’, a confirmation window will open for review of the current settings. After reviewing these 
setting click ‘YES’ if they are correct and the job will be ready to start. Clicking ‘NO’ will cancel, allowing you to go 
back and change settings. 
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SharePoint Collector will then open the site. On the bottom corners of the window, SharePoint Collector will post 
current actions. 

 

In the left window under the ‘Site Collection’ tab, the root site, followed by its sub sites, will be listed. 

Check the sites you wish to collect. 

Checking or unchecking a site will automatically check or uncheck all of the sub sites below it. 
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After checking off which sites to collect, click on the ‘Actions’ tab and choose ‘Get repository contents’. 
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SharePoint Collector will then get a list of the contents of the checked sites. 

 

In the left window, click on the ‘Site Contents’ tab and the pages of the selected sites will appear in a tree view. 
The pages are color coded. 

 

 

 

 

 

Click on the box in front of the page to select it. Clicking on a page will also select/deselect its subpages. 

The number behind the page name is the number of items the page contains. To get an estimate of the number of 
files in the set of checked items, right click on the ‘Site Contents’ window and select ‘Get estimated file count’. 

  

Sites Red 

Document 
Libraries 

Blue 

Folders Green 

Lists, Issues 
and Surveys 

Purple 

All others Black 
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SHAREPOINT COLLECTOR OPTIONS 

 
NOTE: While waiting for SharePoint Collector to gather information from a site, the ‘Options’ page may 
be opened and options may be set. 

 

SITE 

 

Under the ‘Site’ tab, you are able to set whether the URL address provided is for the root of a site, or is used to 
locate the site root. 

 

CONTENTS 

 

Under the ‘Contents’ tab the following options can be set off or on:  

1) Show Document Libraries 
 Turns on/off content collection from SharePoint libraries 

2) Show Lists Contents 
 Turns on/off content collection from SharePoint lists 

3) Include Attachments 
 Turns on/off content collection of SharePoint attachments 

4) Create a User List 
 Turn on/off whether to view content as a whole, or separated by user 

5) Show hidden content 
 Turn on/off hidden content detection and collection. 

NOTE: When this option is selected, ONLY hidden content will be found and collected 
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VERSIONING 

 

The ‘Versioning’ tab contains settings options for exporting document versions. These options allow you to export: 

1) The most recent version: 
 Export only the current file version 

2) The most recent version and version history: 
 Export only the current file version and create a version history file 

3) All versions: 
 Every version of the file will be exported 

NOTE: Estimated counts do not include file versioning counts 
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EXPORT 

 

 

Under the ‘Export’ tab a destination path for the root folder of the exported items can be set. The path can either 
be typed in or can be set by clicking on the folder icon and browsing to the desired location. 
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A manifest file name consists of a prefix followed by the date and time, for example PGI 2012.10.15 12.26.47. The 
manifest file prefix may be set to customize the name of the manifest.  

NOTE: The characters used in the prefix must be legal file name characters. 

The maximum number of concurrent downloads can be set by clicking the up or down buttons to the right of the 
setting. This will allow multiple downloads to run at the same time. Your system and network connection must be 
able to support the extra demands for each additional download.  

 

FILTERING 

 

The data exported can be limited by use of filters. The ‘Filter’ tab allows the selection of a file to be used as a filter. 
The filter file can be created with any text editor and has the following format:  

 

  

[string<equal>] 

Filter string one 

Filter string two 

Filter string three 
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For example: 

  

1) Simply open a text document (such as NotePad) and enter the above format 

 

2) Save the file as Example.ini (Any file name you wish to use is acceptable, but .ini must be used to allow 
SharePoint Collector to use the file as a configuration setting). 

 

3) Select the saved .ini file and click ‘OK’ to save filter options. 

[string<equal>] 

John Smith 

Jane Doe 

Josh Frank 
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 The filter example above limits the exported data to items that have John Smith, Jane Doe, and Josh Frank in the 
metadata fields. 

SHAREPOINT COLLECTOR ACTIONS 

 

Clicking on the ‘Actions’ menu will open a set of actions that are available during the collection. The options will be 
usable at various times depending on the current step of the collection 

Get Repository Contents 

Get the contents for each site checked in the site collection. The site collection must be complete to enable this 
action 
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Creating File List 

Get a list of the files for the selected content item. The site contents (‘Get repository contents’ action) must be 
complete to enable this action. 

 

Export Documents 

Start the export for the selected content items. The site contents (‘Get repository contents’ action) must be 
complete to enable this action 
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Create a Manifest 

Create a manifest file that can be used to export content items at a later time. The site contents (‘Get repository 
contents’ action) must be complete to enable this action 

 

Using the ‘File’ menu ‘Export Manager’ option the manifest may be opened and run. This feature allows the 
creation of a set of exports while looking at the site and content collection lists 

Deactivate a License 

Deactivate the license allowing the SharePoint Collector program to be moved to another computer: 
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SITE COLLECTION 

 

The ‘Site Collection’ tab contains the view of the site and sub-sites of the repository. 

 

SITE CONTENTS 

 

The ‘Site Contents’ tab contains the view of the ‘Lists’ (SharePoint containers) contained in each of the sites that 
where selected in the site collection view. 
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SUMMARY 

 

The ‘Summary’ tab displays information for the immediate child items of either the collection or contents, 
dependent on which tab is active. This tab is a list form of all files within the ‘Site Collection’ tab. 

 

USERS 

 

The ‘Users’ tab is available only when viewing the ‘Site Collection’ view. It contains the SharePoint users list for a 
site. Use the left mouse button to click a site to see the user list. The ‘Users’ tab only show when ‘Create a user 
list’ is checked in the options. 
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FILE LISTS 

 

 

NOTE: The ‘File’ tab is available only when viewing the ‘Site Contents’ view 

To get a list of files for later use and/or reference: 

1) Check the desired Document Libraries under the ‘Site Contents’ tab.  
2) Click on the ‘Actions’ tab at the top and choose ‘Create a file list for the selected items’. 
3) The list may be saved to a CSV file by right clicking on the file list and clicking the Save to file 

button that pops up. You can name the file and path in the resulting window and then click ‘OK’. 
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SHAREPOINT COLLECTOR EXPORT MANAGER 

 

The Export Manager is the component that copies the requested data from the SharePoint sites to the local PC. 

The Export Manager can be launched in two ways. 

1) Clicking on the ‘File’ tab and choosing ‘Export Manager’, the Export Manager can be launched to run 
a previously written manifest or continue one that was interrupted. 

 

2) The Export Manager will launch automatically and begin exporting when you click on the ‘Actions’ tab 
and choose ‘Export documents for selected Items’ after entering a comment. 

 

The comment area can be used for logging or identification purposes and should be something easy to remember 
and/or pertinent to the collection. 
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FILE TAB 

 

 

Open a collection manifest  

This option opens a browser window where you can navigate to a previously saved manifest, choose it, 
and click ‘OK’.  Once a manifest is open, additional options are available. 
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Start collection at the beginning 

Choosing this option will begin an export at the beginning of the manifest. Use this option if you are 
starting a collection from a saved manifest. It can also be used to rerun a manifest from the beginning to 
refresh a collection with new items or attempt to download items that were not successfully exported in a 
previous run. 

 

 

NOTE: When the manifest is opened, there is a check box that controls the disposition of existing files. By 
default it is set to skip files that have previously been retrieved but this can be changed to replace the 
existing files. 

Resume collection from last good item 

This option will begin an export for a manifest that was paused or interrupted, starting from the last item 
that was exported. 

 

 

NOTE: The last item is not the last file but the last container. In a restart there may be several files that 
are shown as skipped. This is normal and is the SPC resynchronizing with the SharePoint server. 
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Pause collection  

This option will pause a running export. It is important to understand that files that are actively being 
exported will complete before the export will pause. 

 

A message will be displayed in the export log indicating the export has been paused. A paused collection 
can be resumed with the ‘Resume collection from last good item’ option. If the ‘Start collection at 
beginning’ option is used, a warning message will be displayed to confirm that a check point exists and 
will be lost if the collection is restarted from the beginning. 

Exit 

This will close the Export Manager. 
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VIEW TAB 

 

 

Chain of Custody 

 This will open a view of the collections Chain of Custody file which is, by default, the Control Records 
window. 

 

A control record is created each time the manifest is run. The data for the control record is Chain of Custody details 
for any files or list that have been downloaded by running the collection manifest.  
 

NOTE: If you use the replace existing files options and rerun a manifest that data following the control 
record will contain file download details for the same files downloaded previously. 

Information contained in the Control Records is: 

1) Family – Position of selected file within a family of files 
2) Record Type – Type of record (Metadata, Posts, Categories, etc.) 
3) Site – Site exporting from 
4) User – User performing export 
5) Time of Export (Local and UTC) – Time export was performed 
6) Differential Time 
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Selecting ‘File’ will give further options regarding record type. 

 

Selecting ‘View All Records’ will open the ‘View All Records’ window, allowing users to view all records associated 
with collection. 
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Error Log 

 This will open a view of the Error Log. 
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The ‘Error Log’ window is a Notepad file containing any errors that occurred during collection. 

 

 

Exception Log 

 This will open a view of the Exception Log. 
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The ‘Exception Log’ window simply contains any exceptions, or files/file types not matching md5 hash values, 
during the collection process. 

 

Manifest 

 This option will open a view of the export manifest. 
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The ‘Manifest’ window contains a WordPad file of the manifest as a text document 

 

EXPORT TAB 

 

 

Another key feature SharePoint Collector has is exporting to concordance files. A concordance file is a list of words 
to include an index. By using concordance export, you are allowing for the creation of a searchable index. 
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Concordance: 

 

Opens a window to options such as ‘Delimiters’, (A sequence of characters used to specify boundaries 
between separate regions in text or data). 

 

‘Numbering’, or number padding, allows for more files to be copied. The “number padding” can be set 
with number of digits, for example, using the NHE prefix and 6 digits, you are allowing NHE000001, or up 
to NHE999999. 
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‘Path and Name’ (‘Output’), the name and location of the export. 

 

Concordance files will be sent to the location of your choice in the form of a .DAT file.  
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POST PROCESSING TAB 

 

 

Create Full Blog Page: 

‘Create Full Page Blog’ will reassemble the items into an html page that resembles the blog as seen in 
SharePoint. When a blog is saved, SharePoint saves each post as a single item. SharePoint Collector simply 
recreates the blog by collecting each item, and putting them back in place in HTML format. 

 

A SharePoint site may contain several blogs. To create the HTML view of a blog, select the exported folder 
that contains the blog and the location to save the HTML. 

 

NOTE: The blog file name is automatically generated. 
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CONTACT INFORMATION 

 

PINPOINT LABS 
8246 Oddo Circle 
Murray, NE 68409 
http://www.pinpointlabs.com  
 

SALES   

  
Phone: 888-304-1096 x 100 
Fax: 402-298-5122 
Email: sales@pinpointlabs.com 
 

SUPPORT   

 
Phone: 888-304-1096 x 102 
Fax: 402-298-5122 
Email: support@pinpointlabs.com 
 

SOFTWARE TRAINING  

 
Phone: 888-304-1069 x 102 
Fax: 402-298-5122 
Email: training@pinpointlabs.com 

http://www.pinpointlabs.com/
mailto:sales@pinpointlabs.com
mailto:support@pinpointlabs.com
mailto:training@pinpointlabs.com
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